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Introduction to BigCloud Archives

In a nutshell, BigCloud lets you create Archives in which you can store
any number of files. You can store all your files in one big archive, or
create lots of archives with more specific groups of files. There are a
few things to consider before you start building your archives:

1. An archive is associated with a "home folder" on your computer.
You might, for example, associate one archive with your "Pictures"
directory and another with your "Documents" directory. You can
choose to automatically import and/or export files from the folder
for automated folder backup, cloning or syncing.

2. An archive is stored locally on your computer, so you have offline
access. You can store some archives on an external disk to easily
move between computers.

3. An archive can be backed up as a whole to another disk or an
online Cloud. You might back up large replaceable files like
movies and music on cheap disks at home, backup picture archives
to a Shared Cloud available to your friends and family, sync office
documents and emails to a Private Cloud used only by yourself,
and publish your resume or blog archives to a Public Cloud for all
to see.

4. An archive may or may not be encrypted - an encrypted archive
requires a passphrase to access any files within it. So you might
choose to store sensitive personal information, email, tax
documents, business plans, etc. in encrypted archives to keep them
as secure as possible. If you forget the passphrase for an archive,
there is no way to recover the files within it - if there were, it
wouldn't be so secure, would it?

BigCloud gives you "Refresh" command that updates an archive from
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backup and performs folder auto-import and export, if enabled.
"Backup" uploads all your changes to the backup location, and "Sync"
performs a refresh and backup together.

Clouds

If you sign up for a subscription to BigCloud Archives Online, you
gain the ability to create and use Clouds to backup your archives, and
to access archives in Public or Private Clouds maintained by other
BigCloud users. A Cloud has a globally unique name which you assign
it, much like domain names are unique on the web, but unlike domain
names a Cloud name may contain punctuation, spaces and non-latin
characters. Like domain names, Cloud names are not case sensitive,
and while punctuation is allowed for legibility, it is ignored when
resolving cloud names (so "hello dolly", "HELLO DOLLY" and
"HELLO DOLLY!!!!!!!!!!" resolve to the same Cloud).

You may create up to 99 clouds with your subscription, and each cloud
can be used to backup an unlimited number of Archives. A cloud may
be Private, Shared or Public, and may be geographically located in a
US or European datacenter. A Private Cloud contains archive backups
that are visible only to you, the owner, on computers where you have
entered a BigCloud Online authorization code obtained from your
Amazon account, while Public Clouds are visible to all other registered
users of BigCloud. With Shared and Public clouds you can assign
access to specific people using their email address or Amazon ID - all
they need is the name of the Cloud to access the archives backed up
within it.

When you sign up for BigCloud Archives Online, you can obtain
authorization codes for as many computers as you want to share access
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to the Clouds on your account.
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Getting Started

To run BigCloud, download the latest version for your operating system from
bigcloud.com. While you're there, consider signing up for the release newsletter to
receive a message when new releases are available. BigCloud requires Java 1.5 or higher
on your system (version 6 or higher recommended) - most computers come with Java
pre-installed, but you may also download it at http://java.sun.com.

Windows

Double-click the downloaded EXE file to start BigCloud Archives

Mac OS X

Double-click the downloaded DMG file to open the disk image; copy the BigCloud
Archives application to your Applications folder, where you may double-click to launch
it.

Linux/other

You may double click the JAR file to run BigCloud, but it will run with limited memory
which could cause problems. We recommend that you open up a command prompt and
run BigCloud with this command to allow BigCloud up to 256 megabytes of memory.

java -Xmx256m -jar /path/to/bigcloud-archives-x.x.x.jar

Setup

When you first launch BigCloud, you will be asked to agree to the licensing terms, and
then you will be asked to enter your name and an Account Passphrase. Your name is only
used as the default Creator when you make archives - you can however assign a different
Creator to an archive. Your account passphrase is very important - it is used to encrypt
your local account settings to prevent unauthorized access. The passphrase is unique to
the computer you are running BigCloud on - you can have multiple computers running
BigCloud synchronized through a single Amazon account, but each may have a different
Account Passphrase.

If you forget your passphrase you will not be able to open BigCloud on that computer any
more - to recover in that case you would have to delete the folder "bigcloud/home" inside
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your user directory and start over, manually re-opening archives and re-entering
passphrases for archives that you had asked to be remembered, and entering a new Online
Authorization Code to sync with your Clouds.

After you set your account passphrase, BigCloud will present you with the preferences
screen, which you can access at any time later under the Edit menu. In the preferences
screen you can configure network proxies, which are often necessary on corporate
networks, and specify the default archive storage location - where you would like new
archives to be stored. You can override this default for any individual archive when you
create or join it. You may also enter an Online Authorization code to enable access to
BigCloud Archives Online, if you are already subscribed. Once you have made any
changes in the preferences screen, hit OK and you are ready to create an archive. You can
have multiple archives open at a time, they appear in tabs across the top of the window.
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Setting up an Archive

To create an archive, select "Create Archive" from the File menu. You will first be asked
to name this archive, and have an opportunity to override the default storage location for
the new archive. For example, you might choose to store the archive on a different disk.
Once you hit "OK", you will be presented with the Archive Settings screen, which you
may open again at any later time under the Edit menu. In the Archive Setting screen you
have several options

1. Home Folder

Here you can associate the archive with a home folder on your computer.
You may also enable synchronization so that the new files in the default
folder will automatically be imported to the archive, and new files in the
archive automatically exported to the folder.

2. Filters

Filters allow you to block files and folders by name from being imported.
For example, if you have chosen to synchronize the archive with your
home directory, you can block Music and Movies folders because you
intend to keep them in a separate archive.

3. Backup

You may back up an archive to a local or network disk, or if you have a
BigCloud Archives Online subscription you may back up to a Private,
Shared or Public cloud. Select "Aggressive Restore" if you want to
download everything from the backup every time you sync - this is useful
if you want to make sure you can access everything in the archive when
working offline. Otherwise, BigCloud only downloads files from the
backup as you view or export them, more like a web site.

4. Schedule

You may configure the archive to sync automatically, e.g. once per day or
once per hour. This way you don't have to remember to manually trigger
the "Sync" command to start a backup.

5. Encryption

You may encrypt an archive with a passphrase, without which the files in
the archive will be unrecoverable. Remember, if there was a way to
retrieve encrypted files without the passphrase, it wouldn't be secure! You
may ask BiandgCloud to remember the passphrase, so you do not have to
enter it every time you open the archive on the same computer. However,
every time you access the archive from another computer you will have to
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enter the passphrase, at which time you may choose to have it remembered
on that computer as well. Encryption guarantees that even someone with
physical access to the disk or cloud servers that hold your archive or
backups will not be able to see what is in your files without the
passphrase. You may change the passphrase periodically for additional
security - when you do, other computers that share the backup of that
archive will also be forced to enter the new passphrase.

Once you have finished making any changes to the archive configuration, click OK, and
you will see your empty new archive open in a tab in the main window. Now you can
start importing files to the archive.
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Importing Files

There are several ways to import files into a BigCloud archive. You may use the Import
Files command from the File menu to browse for folders or files to import from your
computer, and you may use the Import URLs command to enter a list of URLs to import.
You can drag and drop files and folders from your desktop or folder windows into
BigCloud, or drag-and-drop links and images directly from a web browser to import
them. You can also copy or cut files from another archive and paste them into another.

Files are always imported to the archive in the current tab - to import into a different
archive, change tabs to the desired archive, or open it using the Open Archive command.

To import emails to an archive, export them from your mail client in .eml or .mbox files,
and import those files.

You can keep track of the progress of imports in the activity monitor on the right side of
the screen. Once an import has finished, you will see at the bottom right a progress bar
that says "Analyzing Files" - once this is complete your files are ready to be searched,
viewed or backed up within BigCloud. You can safely close BigCloud while it is
analyzing files - it will finish the job the next time you open the archive. If you close
BigCloud during an import, however, the import will be cancelled. You can also cancel
an import using the "Stop" icon next to the progress bar for that import.
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Searching, Browsing and Tagging

BigCloud gives you a number of convenient ways to locate files within an archive.
Directly beneath the tabs on the right side of the screen is a text field you can use to enter
a search query. You can also filter the results by selecting one or more items in the tree
on the left, which shows you folders that you have imported, web sites you have imported
from, addresses you have received mail from, years, months and days on which files were
created, and tags you have assigned to files in the archive. You can right click on any
folder in the tree to pull up a history of that folder - this allows you to browse folders as
they appeared on your computer, and you can select a version of that folder to export it,
including all subfolders.

The dropdown at the top center of the screen describes the current query and filters, and
allows you to quickly return to the results of a previous query. The back and forward
buttons at the top left allow you to easily navigate back to previous views, and the home
button takes you back to the default list view of everything in the archive. The refresh
button triggers an update from backup, as well as folder auto-imports and exports, and the
backup button starts a backup, if one is needed.

In the center of the screen you see the results of the search in a list (or everything in the
archive if you have no search query or filters selected). You can sort the list by the date
files were imported into the archive, by the date the files were originally created, or by
relevance if you have typed in a search query. You can select one or more items in the list
and export them to your computer using the "Export Files" command, add or remove tags
from them using the tag area to the right, copy or cut them to paste into a different
archive, or if they are images rotate them using CTRL-L or CTRL-R keys for left and
right, respectively (Apple-L and Apple-R on macs). You may also remove selected items
from the archive using Delete from the Edit menu. Right clicking on an item allows you
to pull up the history of the file or URL it was imported from. You can double click on
any item or hit Enter on a selected item to view it in detail. You may also use the Items
and Details buttons at the top to switch between List and Detail view. In detail view you
may tag the displayed item, or use playlist controls to play or pause a slideshow
(ctrl-spacebar), or move to the next or previous items in the list (arrow keys).
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Synchronizing

The "Sync" command (command or ctrl-S) performs a backup and/or restore of an
archive. It keeps your local copy of the archive backed up and updated with other files
backed up from other computers. Files are normally downloaded to your computer as you
view or export them. You can select "Aggressive Restore" in the Backup section of the
Archive Settings dialog to download every file backed up from other computers during a
sync, which guarantees availability for offline use.

Synchronizing with a folder

Folder synchronization allows you to keep a folder on your computer and an archive in
sync with one another. If you have multiple computers sharing a backup of the archive, it
will in turn allow you to keep folders in sync across those multiple computers. To enable
this, use the checkboxes for automatic import and export in the Home Folder section of
Archive Settings under the Edit menu.

Exporting Files

When you export files or folders (by selecting one or more items in List view, or the
current item in Detail view), you are asked to choose a folder to export them into, and if
there are files already existing in that folder you are asked whether you want to "clobber"
the contents of that folder - clobbering will overwrite existing files in that folder with the
same name as files you are exporting. Otherwise, BigCloud will rename the exported
files and leave the existing files in the export folder untouched.

Folder & File History

BigCloud keeps track of changes to folders, files and URLs - you can right click on any
folder or file in List view to pull up the history of that location. Folder histories are only
available if you have imported the entire folder, not just files within it.
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Introduction to BigCloud Archives Online

BigCloud Archives Online is a low-cost subscription service that allows you to backup
your archives to a secure Cloud hosted by Amazon. You may create up to 99 Clouds with
your subscription, each with a unique name, and each of them may be designated Private,
Shared or Public.

To activate a copy of BigCloud Archives to use with an Online subscription, go to
bigcloud.com, click the Subscribe link at the top of the page and enter your Amazon
username and password. If you are already subscribed, you can retrieve as many
authorization keys as you like for as many computers as you like - otherwise you will be
invited to sign up for a subscription. Once you have activated a copy of BigCloud
archives, you can access Clouds.

Use Private clouds to back up personal files; these clouds are only accessible from
computers where you have entered an activation code from your subscription. Shared
clouds allow you to grant read or write access to up to 30 or more other subscribers by
their email address or Amazon ID - great for family photo albums. Public clouds are
visible to any other BigCloud subscriber - you can use these for publishing, like a
multimedia blog. All a person needs to know to access a Public Cloud, or a Shared
Cloud they are permitted to see, is the name of the Cloud.

Setting up a Cloud

To create a cloud, you can either go the Clouds screen of the Preferences dialog (under
the Edit menu), or select "Backup to BigCloud Archives Online" in the Backup section of
Archive Settings (also under the edit menu). In either place you will see a list of your
existing clouds, and you can click "Create Cloud" to add a new one. When you create the
cloud you assign its Name and whether you want it to be stored in US or European data
centers. These settings cannot be changed later, except to delete and recreate the cloud,
which will erase all the data backed up to it.

Once the Cloud is created, the Edit Cloud dialog appears, where you can choose to make
the Cloud Shared or Public, or keep it private. You can grant additional access to users
for Shared and Public Clouds using the "add user" button and checkboxes for read, write
and share access levels. A user with "share" access can add additional users to the cloud.
You can also enable "Requester Pays" for Shared or Public Clouds so that other users pay
for the bandwidth they consume when they access your Cloud. These settings can be
changed any time.
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Joining an existing backup

To access an existing archive backup on a Cloud or disk, use the "Join Backup"
command under the File menu. Select "BigCloud Archives Online" or "Local or Remote
Disk", and click "Choose Backup Location" to select the Cloud or folder where the
backup is located. You may specify a location other than the default where you would
like your local copy of the archive to be stored, then click OK. If you have write access to
the backup (if it is on a Cloud you own, or a remote folder), when you Sync you will
upload your changes and download changes backed up from other computers. If the
backup is stored on someone else's Cloud, syncing will pull down the latest from the
Cloud, but any changes you have made locally (e.g. adding tags) will not be backed up.
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Sharing a Cloud

When you create a Cloud you have the option to set up sharing for the archives in that
Cloud. By default, Clouds are private, meaning you can only access them with your
subscription. However, you may choose to make your Cloud Shared or Public and assign
read, write or full access to other users with their email address or Amazon ID. A Public
cloud is also visible to any other BigCloud subscriber - they can read, but not write,
Archives in that Cloud.

When you share a Cloud, you also have the option to enable "Requester pays", so that
other users will be responsible for paying for the bandwiidth they use downloading or
uploading to the Cloud. As the owner, you will still be responsible for the storage costs.

You can change the sharing setup for a Cloud at any time by going to the Cloud list in
the Preferences screen, and clicking the "Edit" button. You can also reach the sharing
controls from the Backup configuration of an Archive, when you click "Change Backup
Location" with BigCloud Archives Online selected, you can also select a Cloud and press
"Edit".
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LAN Setup

If you have a local network with several computers that you would like to share archives,
you may find it useful to set up one primary computer on the network to back up to a
Cloud, and have all the other computers on the network back up to the primary computer.
This will speed up syncs from all the other computers and reduce your Amazon bill by
keeping most of the data transfers inside your network, while still allowing you to keep a
copy in a Cloud. To do this, you will need to set up the archive storage folder on the
primary computer as a network share, and then use the "Backup to network disk" option
on all the other computers to sync with that share. You might find it particularly
convenient to leave BigCloud open on the primary and schedule a regular sync so that
backups and restores to the cloud are automated.
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Recognized file types

• Email (*.eml and *.mbox)
• PDF
• Web pages
• Text, RTF & XML
• Office documents

Microsoft Word, Excel & Powerpoint
StarOffice Writer, Impress, Draw, Calc, Math

OpenOffice Text, Presentation, Graphics, Spreadsheet

• Images

JPEG, GIF, PNG, TIFF, BMP, PhotoShop, XCF

• Audio

MP3, FLAC, WAV, MP4

• Video

AVI, WMV, FLV, MOV, MPEG, MKV (Matroska)
- thumbnail support requires separate install of ffmpeg

• Compressed files

ZIP, TAR, GZ, BZIP, RAR, SIT, DMG, JAR
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Privacy and Security

Today's internet user is all too aware that privacy on the web is at best a good intention -
while companies want to avoid the public relations nightmare of revealing too much
information about you, the fact is they are collecting vast amounts of information about
you, tracking your every click, every search term, even reading your email to figure out
what ads to serve you. They have all this information about you and ask you to trust their
good intentions - but very few will reveal details about how securely this data is kept, or
what safeguards they have to prevent their own employees or contractors from accessing
or abusing your personal information.

BigCloud offers something much better than privacy by intent - we give you privacy by
design. First of all, BigCloud as a company has no access to your files, even those stored
on BigCloud Online - that service is hosted by Amazon and there is no "back door" for us
to get in to see what you have. The BigCloud software you install on your computer does
not record or report any of your usage, and all searches you perform in BigCloud
Archives are made against a local index of an archive that is securely downloaded to your
computer - your search terms never cross the network to reach a server that might log it
for years. Amazon meters your usage in terms of bytes stored and transferred, in order to
bill you accurately, but unlike some other big internet companies they are not looking at
what is in those transferred bytes to learn more about you.

Another fundamental privacy concern with storing your personal files on a web site is
that by design, anything you can see in a web browser can also be seen by the server that
delivers it, and potentially by a "man in the middle" - there are many ways your privacy
can be compromised. When you store your files in an encrypted BigCloud Archive, by
assigning a passphrase to that archive, you guarantee that even someone with access to
the physical servers that host your files on the cloud, or someone who somehow
intercepts the secure connection between your computer and the cloud, will not be able to
to see the contents of those files without first cracking your passphrase, which we make
as difficult as possible by using industry-standard encryption protocols like AES-128 and
PBKDF2 and through the liberal application of randomized salts to prevent rainbow or
pattern-detection attacks. In this way BigCloud Archives gives you a peace of mind you
can never get through your web browser.
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Open-source dependencies

BigCloud Archives relies on a number of open-source components to provide specific
functions. Here is a list of all the open-source libraries used by the current release of
BigCloud Archives.

• SLF4J
• Apache Lucene
• Apache Commons Codec
• Apache Commons Sanselan
• juniversalchardet
• pdfbox
• bouncycastle
• Apache POI
• JAudioTagger
• TagSoup
• Apache HTTPClient
• EventBus
• SimpleLog
• XHTMLRenderer
• JRawIO
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